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Welcome
Welcome to the Belysa® Immunoassay Curve Fitting Software User Guide.

Technical Support

For technical support and product updates, please visit www.sigmaaldrich.com/belysa

Notices

For Research Use Only. Not For Use In Diagnostic Procedures.

We provide information and advice to our customers on application technologies and regulatory matters
to the best of our knowledge and ability, but without obligation or liability. Existing laws and regulations
are to be observed in all cases by our customers. This also applies in respect to any rights of third
parties. Our information and advice does not relieve our customers of their own responsibility for
checking the suitability of our products for the envisaged purpose.

© 2022 Merck KGaA, Darmstadt, Germany and/or its affiliates. All Rights Reserved.

MilliporeSigma, the vibrant M, Millipore, Belysa, and SMCxPRO are trademarks of Merck KGaA,
Darmstadt, Germany or its affiliates. All other trademarks are the property of their respective owners.
Detailed information on trademarks is available via publicly accessible resources.

http://www.sigmaaldrich.com/belysa
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Getting Started

Here are some steps to get started using Belysa® immunoassay curve fitting software:

Step 1: Install Software

If you haven't already done so, you should start by running one of the install programs located on the
included USB flash drive. See Install Software for steps on how to run the installer program.

Step 2: Connect License Dongle

Next you should connect the included license dongle to your computer via an available USB port. The
license dongle requires no additional driver installation.

Step 3: Open a File

Belysa® software can analyze data from a variety of different sources. To learn how to open a data file in
Belysa® software, see Open Files.

Step 4: Analyze Results

Once you have opened your data, you can use the wide variety of analysis tools provided by Belysa®
software to evaluate the performance of your assay. You can start by familiarizing yourself with the
application Interface, or by reading about some of the application's key Features.

Step 5: Produce Reports

See Reports to learn about the different ways to export data from Belysa® software.

Step 6: Save Your Work

When you are finished analyzing your data, save your work to a Results file by following the steps in
Save Results File.



20400304 Rev. 3.0 7 of 97 Catalog # 40-122

Install Software

System Requirements

Belysa® immunoassay curve fitting software requires a 64-bit Windows 10 operating system. One
available USB-A port is required to attach the provided license dongle.

Installation Instructions

Follow these steps to install Belysa® software on your computer:

1. Identify the correct installer file for your system. If you are running a 64-bit version of Windows,
choose Install-Belysa-1.X.X-x64.exe (where 1.X.X is a variable version number).

2. Start the installer program by double-clicking on the executable identified in Step 1. The installer
program will start:

3. Follow the on-screen instructions to install the software, entering an administrator password if
prompted.

4. When complete, select Finish to exit the installer. Select Run Belysa now to open Belysa®
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software after the installer exits:
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Uninstall Software

Follow these steps to uninstall Belysa® immunoassay curve fitting software from your computer:

1. Navigate to the Belysa® software install directory (e.g. C:\Program Files\Belysa) and double-
click on the file Uninstall-Belysa.exe. Alternatively, you may uninstall the software via the
Windows Control Panel Add/Remove Programs feature.

2. The uninstall program will start:

3. Follow the on-screen prompts to complete the uninstall process. When complete, select Finish to
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exit the uninstaller:
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Features
Here are the key features and concepts in Belysa® immunoassay curve fitting software you are most
likely to use when analyzing your data:

l Opening Files
l You can open files from multiple data sources, including Luminex® xPONENT® and
SMCxPRO® platforms. See Open Files.

l Single and Multi-Analyte Views
l You can view your data in different ways, focusing on a single analyte or a single value
across all analytes. See Single and Multi-Analyte Views.

l Plates
l Belysa® software supports 96-well and 384-well formatted plate data. See Plates.

l Experiments
l Belysa® software organizes results into workspaces called experiments. See
Experiments.

l Auto-Flagging
l Belysa® software's auto-flagging features make it easy to quickly identify potential issues
with your data. See Auto-Flagging.

l Excluding Wells
l Wells can be excluded from result calculations by well and by individual analyte. See
Exclude and Include Wells.

l Show and Hide Table Columns
l To learn how to customize your result views, see Show and Hide Table Columns.

l Produce Reports
l Export your data to a variety of report formats. See Reports.
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Open Files

Belysa® immunoassay curve fitting software supports opening the following types of files:

l SMCxPRO® Data and Results files (*.xpd, *.xpr). See Opening SMCxPRO® Files
l xPONENT® files (*.csv). See Opening xPONENT® Files
l Bio-Plex Manager™ Multi-Analyte Export files (*.xlsx, *.xls). See Open Bio-Plex Manager™
Files.

l Generic ELISA data using the supplied Excel template (*.xlsx). See Open Generic Data Files.
l Belysa® software Results files (*.belysa). See Opening Results Files.

Opening SMCxPRO® Files

How to open SMCxPRO® Files

You can open XPD and XPR files containing SMCxPRO® instrument data by one of the following methods

l On the menu bar select File > Open... to display the Open File dialog. Navigate to the file you
want to open, select it, and then click Open.

l Use the keyboard shortcut Ctrl+O. The Open File dialog displays. Navigate to the file you want to
open, select it, and then click Open.

l Drag the file from your computer's file system onto the center of the Belysa® software application
window

Data extracted from file

Belysa® software can recognize and import the following information from SMCxPRO® files

l Plate maps (one or more plates)
l Replicate groups
l Expected concentrations for Standard and Control wells
l Unknown dilution factors
l Response and other raw data values
l Experiments, including standard curves and curve fit selections
l Test information

Opening xPONENT® Files

How to open xPONENT® CSV files

You can open an CSV file generated by xPONENT® software in the following ways:

l Drag the file from your computer's file system onto the center of the Belysa® software application
window
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l On the menu bar select File > Open... to display the Open File dialog. Navigate to the file you
want to open, select it, and then click Open.

l Use the keyboard shortcut Ctrl+O. The Open File dialog displays. Navigate to the file you want to
open, select it, and then click Open.

Data extracted from file

Belysa® software can recognize and import the following information from xPONENT® Version 3.1 and
4.2 CSV files if it is present:

l Plate map
l Replicate groups
l Expected concentrations for Standard and Control wells
l Unknown dilution factors
l Analyte names, bead regions, and units
l Median and Count values
l Header information

Open Bio-Plex Manager™ Files

Belysa® immunoassay curve fitting software can open Excel reports generated by Bio-Plex Manager™ as
long as the following conditions are met:

l The report must use the Multiple Analyte Layout
l Show Replicates must be selected
l The FI column must be visible

How to open a Bio-Plex Manager™ Excel File

To open a Bio-Plex Manager™ Excel report file, use one of the following methods

l On the menu bar select File > Open... to display the Open File dialog. Navigate to the file you
want to open, select it, and then click Open.

l Use the keyboard shortcut Ctrl+O. The Open File dialog displays. Navigate to the file you want to
open, select it, and then click Open.

l Drag the file from your computer's file system onto the center of the Belysa® software application
window

Before opening the file, the Source Data Type dialog will appear asking you to select the source data
type. In this case, choose Bio-Plex Manager Multi-Analyte Export File
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Data extracted from file

Belysa® software can recognize and import the following information from Bio-Plex Manager™ files

l Plate map
l Replicate groups
l FI (MFI) values

Open Generic Data Files

If you have plate-formatted data you'd like to analyze using Belysa® software, you can import it using a
provided Excel input template.

How to enter data into the provided Excel template

1. Navigate to the Belysa® software installation directory and open the Templates folder

2. Open the Belysa Input Template.xslx. The template included with the software is not editable,
so in the next step we will make a copy to use for your data

3. Go to File > Save As and save a copy of this template on your desktop or other writeable
location. You may give the copied template a different name.

4. If not already opened, open the copy of the template you made in the above step

5. Follow the directions on the Instructions tab to enter your data into the template

6. When you are finished, save the template as an Excel Workbook (.xlsx) file

How to open an Excel template containing data

To open an Excel template workbook containing generic data, use one of the following methods

l On the menu bar select File > Open... to display the Open File dialog. Navigate to the file you
want to open, select it, and then click Open.

l Use the keyboard shortcut Ctrl+O. The Open File dialog displays. Navigate to the file you want to
open, select it, and then click Open.

l Drag the file from your computer's file system onto the center of the application window
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Before opening the file, the Source Data Type dialog will appear asking you to select the source data
type. In this case, choose Belysa Generic Input Template File

Data extracted from file

Belysa® immunoassay curve fitting software can recognize and import the following information from
generic input template files:

l FI (MFI) values
l Analyte names
l Header information

Opening Results Files

You can open a Results file generated by Belysa® software in the following ways:

l On the menu bar select File > Open... to display the Open File dialog. Navigate to the file you
want to open, select it, and then click Open.

l Use the keyboard shortcut Ctrl+O. The Open File dialog displays. Navigate to the file you want to
open, select it, and then click Open.

l Drag the file from your computer's file system onto the center of the Belysa® software application
window
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Single and Multi-Analyte Views

Belysa® immunoassay curve fitting software provides you with two ways to view and report your
multiplex assay data. In single-analytemode, all information is displayed for one analyte at a time. Each
column in a table represents a different statistic, and all rows represent the same analyte. Inmulti-
analytemode, information about all analytes is shown for a single statistic (i.e. Result, Recovery, etc.) at
a time. In this mode, each column in a table represents a different analyte, and all rows represent the
same statistic. To switch between single and multi-analyte views of your data, use the Analyte View
Toolbar.

Here is an example of a table in single-analyte format, showing all statistics for a single analyte:

Here is an example of a table inmulti-analyte layout, showing a single statistic for multiple analytes:

The following report output formats support both single-analyte and multi-analyte formats:

l TXT
l CSV
l Excel

The PDF report currently only supports a single-analye layout.
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Experiments

An experiment contains the data being used for analysis. An experiment can contain one or more
standard curves, each of which may be associated with one or more sample groups. Each experiment is
reported separately into its own text, Excel, or PDF files. There are two types of experiments:
quantitative experiments, which display interpolated concentration values for sample groups associated
with a standard curve, and relative potency experiments, which display measures of similarity between a
control curve and one or more comparison curves.

For more information about working with experiments, see:

l Create an Experiment
l Add Standard Curves to an Experiment
l Edit Experiment Name and Details
l Experiment Results

Create an Experiment

A Results file can contain one or more experiments. To create a new experiments, follow these steps:

How to Create an Experiment

1. To add a new experiment, select the Add Experiment button to display the shortcut menu, then
select either New Quantitative Experiment or New Relative Potency Experiment
depending on your experiment type:

Add Standard Curves to an Experiment

To add a standard curve to an experiment, first make sure you have created a standard group on your
plate (see Create Groups), and that you have added an experiment to your Results file (see Create an
Experiment). There are two ways to add a standard curve to an experiment:

Method 1: Drag and Drop from Plate to Experiment

To add a standard curve to an experiment by dragging and dropping, perform the following steps:
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1. In the Plates tree, left-click the standard group you wish to add

2. Drag the standard group to the Experiments tree, dropping it on an experiment

Method 2: Use Shortcut Menu

You may also add standard curves to experiments by right-clicking on a group in the Plates tree, and
using the context (pop-up) menu commands:

1. In the Plates tree, right-click the standard group you wish to add to open the shortcut menu

2. Hover over the Add as Standard Curve option, and then select the name of the experiment
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Add Sample Groups to a Standard Curve

To obtain quantitative results for a sample group, first make sure you have created one or more groups
on your plate (see Create Groups), and that you have added an experiment to your Results file (see
Create an Experiment). Your experiment should have at least one standard curve (see Add Standard
Curves to an Experiment). There are two ways to add a sample group to a standard curve:

Method 1: Drag and Drop from Plate to Standard Curve

To add a sample group to a standard curve by dragging and dropping, perform the following steps:

1. In the Plates tree, click the sample group you wish quantify.

2. Drag the standard group to the Experiments tree, dropping it on top of a standard curve group (as

indicated by the icon):
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Method 2: Use Shortcut Menu

You may also add sample groups to standard curves right-clicking a group in the Plates tree, and using
the shortcut menu:

1. In the Plates tree, right-click the standard group you wish to add to open the shortcut menu.

2. Hover over the Add as Standard Curve option, and then select the name of the experiment:

Change the Curve Fitting Method

Belysa® immunoassay curve fitting software provides several regression methods for fitting standard
curve data, including:

l 4PL (standard and robust models)
l 5PL (standard and robust models)
l Linear
l Cubic Spline
l Competitive

For a more detailed description of the differences between the different regression options, see
Mathematical Reference.

How to change the curve fit for a single analyte

In single-analyte view

1. Select an analyte from the Analyte list on the toolbar, or press Ctrl-K on the keyboard and then
type the name of the analyte.

2. Go to the Curve Editor tab in the right panel

3. In the standard curve tree, click the name of the curve you wish to modify



20400304 Rev. 3.0 21 of 97 Catalog # 40-122

4. In the curve details table, find the Fit row and double-click the current value to activate the Curve
Fit list. Select a new curve fit and the results will update automatically:

In multi-analyte view

1. Go to the Curve Editor in the right panel

2. In the standard curve tree, click the name of the curve you wish to modify

3. Double-click in the Fit column next to the name of the analyte whose curve fit you wish to modify.
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This activates the Curve Fit list. Select a new curve fit and the results will update automatically:

How to copy a curve fit between analytes

In single-analyte view

1. Select an analyte from the Analyte list on the toolbar, or press Ctrl-K on the keyboard and then
type the name of the analyte

2. Go to the Curve Editor in the right panel

3. In the standard curve tree, click the name of the curve you wish to modify
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4. Select the Copy Fit to All Analytes button to copy the current analyte's fit to all other analytes
for all curves in this experiment

How to copy a curve fit to all curves

In single-analyte view

1. Select an analyte from the Analyte list on the toolbar, or press Ctrl-K on the keyboard and then
type the name of the analyte

2. Go to the Curve Editor in the right panel

3. In the standard curve tree, click the name of the curve you wish to modify

4. Select the Copy Fit to All Analytes, All Curves button to copy the current analyte's fit to all



20400304 Rev. 3.0 24 of 97 Catalog # 40-122

other analytes for all curves in this experiment

Optimize Curve Fit

Belysa® immunoassay curve fitting software can automatically select the best fit and identify outliers for
your standard curve data. For detailed information on how curve fit and outlier optimization are
performed, see Curve Optimization. Note that curve optimization always operates on all analytes,
regardless of whether you are in single-analyte or multi-analyte view (see Single and Multi-Analyte
Views).

How to optimize the curve fit and/or outliers

1. In either single-analyte view or multi-analyte view, go to the Curve Editor in the right panel

2. In the standard curve tree, click the name of the curve you wish to modify

3. Select Optimize..
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4. The Optimize Curve Fit (All Analytes) dialog will appear:
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The options for curve fit optimization are as follows:

Option Description

Optimize curve fit and remove outliers
Performs both curve fit optimization and outlier removal
on the selected curve for all analytes

Only optimize curve fit
Performs only the curve fit optimization method on the
selected curve for all analytes

Only remove outliers
Performs only the outlier removal method on the selected
curve for all analytes

Outliers removed by the optimization method will have their Exclude Reason updated to read "Set by
optimize outliers command".

Change Curve Plot Appearance

When viewing the results of an experiment, you can customize the appearance of the standard curve
plot.

How to Customize Standard Curve Plots

1. Go to the Curve Editor tab in the right panel of the experiment results screen

2. At the top of the Curve Editor tab, locate the standard curve tree. Click the arrows next to the
curve names to view sample groups:

3. Change the appearance of the plot in one or more of the following ways:
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Change Color

a. Double-click the colored rectangle in the Color column next to the element whose color you
wish to change. In the Color list, select the desired color. Alternatively, select Custom...
to choose a custom color. Note: color settings for groups will be saved to the Results file.

Toggle Visibility

a. Select or clear the Visibility check box next to the group's name to show or hide the group
on the plot. Selecting the check box next to a standard curve will show or hide all sample
groups associated with that curve. Note: visibility settings for groups are not saved to the
Results file.

Import an External Standard

Curve fits from external files may be used to quantify sample groups contained in the currently opened
Results file, and/or be included in relative potency calculations.

How to import an external curve

1. When viewing experiment results, go to File > Import > Import External Curve...

2. In the Import External Curve dialog, select the Browse... button and choose a Belysa® software
Results file containing the external curve fit

3. If the external Results file contains at least one analyte in common (as determined by ID) with the
currently opened file, you may select one or more standard groups to import:
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4. When you are finished selecting groups to import, select OK. The external standard groups will be
added to the current experiment named with an "Ext." prefix.

Note: Imported external standards will not be saved to the Results file. You should export any
reports needed for this experiment before closing the file.

Edit Experiment Name and Details

The following details are available for each experiment:

l Name
l Description
l Created By (automatically populated with user name)
l Created On (automatically populated with time experiment was created)

How to change experiment details:

1. Go to the Experiment Details tab

2. Enter a new experiment name in the Name box
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3. Enter an experiment description in the Description box

Notes

l Experiment names have a maximum length of 100 characters
l When you are finished editing the experiment name or description, select an area outside of the
text box to commit your changes
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Plates

A plate in Belysa® immunoassay curve fitting software represents a 96-well or 384-well microplate,
depending on the format of the source data. Each well on the plate is referenced by its location,
represented as its row letter (A, B, C, etc.) plus its column number (1, 2, 3, etc.). For example, location
A3 refers to the well in row A column 3.

To view and edit well information, including groupings and replicates, use the Plate Map Editor. Other
common tasks involving plates include:

l Create Groups
l Cut, Copy, & Paste Wells
l Clear Well Information

Create Groups

Plates may contain one or more groups of wells. Groups can be added to experiments in order to obtain
results.

How to Create a Group

1. At the bottom of the screen, go to the Results tab or press Ctrl+1 on your keyboard:

2. Select the name of the plate you wish to edit. This will display the plate map:
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3. Select wells to group. Belysa® immunoassay curve fitting software can automatically populate
replicate count and direction based on how you select the wells to group. For example, to create a
group with 8 replicate groups, each with a replicate count of 2, arranged horizontally, you could
first select two columns like this by dragging with the mouse:

and then drag down to complete the selection:
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It is also possible to change the replicate count and direction in the next step, so while following
these selection guidelines may be convenient they are not required.

4. Select group type and enter information. Once you have selected wells for the group, select one of
the three group types by clicking the appropriate icon on the toolbar, right-clicking and selecting
the group type from the shortcut menu, or by using a keyboard shortcut:

Icon Shortcut Type Description

Ctrl+D Standard
In a Standard well, you have a known
concentrations of analyte in a standard diluent,
values that are used to form standard curves.

Ctrl+F Control
Similar to the Standard, these wells have known
concentrations of analyte in a sample matrix; used
to measure run-to-run variability.

Ctrl+G Unknown
The Unknown well is where you are measuring for
an unknown concentration.

In the resulting dialog window, enter additional information about the group:
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1. Enter a unique name for the new group. To append wells to an existing group instead of
creating a new one, use the dropdown to select the name of the existing group.

2. Enter the desired replicate pattern. These settings are pre-populated based on how you
selected the wells, but you may change them if desired:

l Count - number of replicates in the replicate group
l Direction - whether to group replicates going down the plate(vertical) or across the
plate(horizontal)

3. Enter dilution information:
l Dilution Factor - the ratio of the dilution, such as 1:2, 1:3, etc. For Standard and
Control groups, this will be used to calculate Expected Concentration values. For
Unknown groups, this will be used as a multiplier to adjust the interpolated result.
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l Type (Standard and Control only) - specifies whether the highest concentration is at
the top/left of the plate (High to Low), or at the bottom/right of the plate (Low to
High)

l Blank Well (Standard and Control only) - if checked, the lowest Expected
Concentration in a group of diluted samples is automatically set to 0.00 (blank)

4. Enter high concentration for each analyte (Standard and Control only). Selecting the
Autofill button will copy an analyte's high concentration to all analytes below it.

Clear Well Information

The Clear Wells action will remove the following information about a well:

l Group
l Replicate number
l Sample ID
l Expected Concentration
l Dilution Factor

The following information will not be cleared:

l Response (MFI), other raw data
l Run Status
l Excluded status and reason

How to Clear Well Information

1. At the bottom of the screen, go to the Results tab or press Ctrl+1 on your keyboard.

2. Click the name of the plate you wish to edit. This will display the plate map for the plate.
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3. Select wells to clear. When clearing wells, the order in which you select wells doesn't matter.

4. Select Clear Wells on the toolbar, or right-click and select the Clear Wells from the shortcut
menu to clear well information

Cut, Copy, & Paste Wells

You can cut, copy, and paste well formatting from one part of a plate to another in order to quickly create
multiple groups. This is useful when your source data does not contain formatted plate information (i.e.
all unknown wells). When you paste wells, the following information is transferred:

l Group type
l Replicate pattern
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l Sample ID
l Expected Concentration (for Standards and Controls)
l Dilution Factor (for Unknowns)

How to Cut, Copy, & Paste Wells

1. Select some wells on the plate map editor

2. Select Cut or Copy on the toolbar to cut or copy wells. Alternatively, use the keyboard
shortcuts Ctrl+X for cut and Ctrl+C for copy. If you choose to cut wells, the highlighted wells will
be cleared (see Clear Well Information).

3. Select the well at the top-left corner of where you would like to paste the cut or copied well
information
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4. Select Paste to paste well information. A new group will be created with the same replicate
pattern, sample IDs, and concentrations as the wells you cut or copied:
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Renumber Replicates

When viewing the plate map, wells are numbered such that wells with the same number will be have
their results averaged together when viewing experiment results. Wells with the same number are
known as replicates. As you add and remove groups on the plate, the replicate number for new groups
continues to increment (1, 2, 3, etc.). Renumbering replicates will make the replicate numbers start at 1
without changing the replicate pattern.

Note: This action does not affect results in any way, it only changes the numbers assigned to each
replicate group
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How to renumber replicates

1. In the Plates tree, select the name of the plate you wish to edit. This will display the plate map:

2. Select Renumber Replicates from the toolbar
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3. Observe that the replicate numbers have now restarted from 1:

Edit Plate Name and Details

The following details are available for each plate:

l Name
l Description
l Created By (automatically populated with user name)
l Created On (automatically populated with time experiment was created)

How to change plate details:

1. Go to the Plate Details tab

2. Enter a new plate name in the Name box
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3. Enter an plate description in the Description box

Notes

l Plate names have a maximum length of 100 characters
l When you are finished editing the plate name or description, select an area outside of the text box
to commit your changes

Rename Plates and Groups

You can give plates, quadrants, and groups custom names to help organize your results.
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How to rename a plate, quadrant, or group

1. Go to the Results tab and find the Plates tree:

2. If necessary, expand the plate or quadrant to show all sub-items

3. Right-click a plate, group, or quadrant and select "Rename <current name>" from the shortcut
menu
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4. Type in a new name for the item and press Enter:
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Auto-Flagging

Belysa® immunoassay curve fitting software can automatically flag data that falls outside certain

thresholds. When a value is flagged, the icon will appear next to the value in the table.To learn how
to manage your auto-flag rules, see Create, Update, and Delete Auto-Flag Rules. To exclude all
wells with certain flagged values, see the Exclude All Flagged action in the Raw Data Toolbar.

Create, Update, and Delete Auto-Flag Rules

To view your currently defined auto-flag rules, open the User Settings dialog by going to Tools >
Settings and selecting Auto-Flag from the list (see Settings and Preferences):

Each auto-flag rule has the following editable components:

Column Description
Active Selecting this box applies the rule to your results. Clear the box to temporarily suspends
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running this rule.
Parameter The statistic to which this rule applies

Rule

The type of comparison that will be applied to the parameter value when compared to the
rule's limit value. The choices are:

l < Less than
l <= Less than or equal to
l > Greater than
l >= Greater than or equal to
l = Equal to

l ≠ Not equal to
Limit The threshold value to which the parameter will be compared

For example, the rule shown below will show a flag icon next to any Recovery value that is less than
80%:

You can set up different auto-flag rules for different instrument data types. Before changing your auto-
flag rules, ensure that you have selected the correct data type from the Show rules for box.

Once you have selected the data type, you can alter your auto-flag rules. To add a new auto-flag rule,
select the Add Rule button. A new row will be added to the rule list. To change an auto-flag rule, click in
cell you wish to change and enter or select a new value. To remove an auto-flag rule, select any cell in
the row you wish to remove and select the Remove Rule button. To reset rules for this data type back
to their factory default values, select the Reset button.

Changes to auto-flag rules will be applied as soon as you select the Apply or OK buttons.



20400304 Rev. 3.0 46 of 97 Catalog # 40-122

Exclude and Include Wells

Belysa® immunoassay curve fitting software provides the ability to exclude certain well data from
results calculations. This can be used to suppress outlier data or data that fails to meet certain quality
thresholds (see Auto-Flagging). You can exclude some or all analyte data for a particular well. When
you exclude data, the data is excluded from all Experiments in the file.

There are multiple ways to exclude and include data in the application:

l To exclude data while viewing experiment results, see Quantitative Experiment Results
l To exclude data while viewing raw data, see Raw Data Table
l To exclude data while viewing the standard curve, see Standard Curve Plot
l To review excluded data, see Excluded Wells Tab
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Show and Hide Table Columns

Many data tables in Belysa® immunoassay curve fitting software provide the ability to customize which
columns are visible and what order they appear in. In some cases, these preferences can be saved for all
subsequent files you open.

How to show and hide table columns

To show and hide table columns, go to the Table Columns tab when viewing Experiment Results or
the Raw Data Tab

Table columns can be customized in the following ways:

l To hide a table column, clear the check box next to the column's name. Select the check box to
show it again. To hide all columns, select the Unselect All button. To show all columns, select the
Select All button.

l To rearrange columns, select the column name so that is highlighted and select theMove Up and
Move Down buttons. Alternatively, you can drag and drop the columns into different orders in
this tab or in the table itself



20400304 Rev. 3.0 48 of 97 Catalog # 40-122

l To save the current selections as your default for subsequent files, select theMake Default
button (note that this option is not available for multi-analyte tables). To restore your default
settings, select the Restore Default button

l To revert back to the application default settings, select the Reset button
l To sort the table by different columns, click on the column's header in the data table
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Reports

Belysa® immunoassay curve fitting software can save your data and analysis settings to a Results file
(.belysa), as well as produce reports in tab-separated text (.txt), comma-separated text (.csv), Excel,
and PDF formats. To learn more about producing reports, see the following sections:

l Save Results File
l Export to Text or CSV
l Export to Excel
l Export to PDF

Save Results File

Belysa® immunoassay curve fitting software results are saved as a Results file (.belysa). This file
preserves the following information:

l All plate and experiment data, with the exception of external standard curve data
l Curve fit selections
l Curve color
l Analyte names, units, and precision

To save a Results file, select File > Save or File > Save As... from the menu bar.

Export to Text or CSV

Exporting data to text files (tab-separated .txt or comma-separated .csv) is supported by the
Experiment Results view and the Raw Data Tab. You can export data in single-analyte format or
multi-analyte format (see Single and Multi-Analyte Views). In single-analyte format, each row
displays all of a single analyte's data for a single well. In multi-analyte format, each row displays a single
statistic (i.e. Recovery) for a single well across all analytes.

To export data to a text file, select Export to TXT or Export to CSV on the toolbar. Depending
on your preferences, the Report Options dialog may appear:
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Use the Columns tab to select what data will be included in the report. Select As Displayed if you want
the arrangement and sorting of the data columns in your report to match the way you have configured
the columns on the screen. Select All Columns to use the application default columns and sorting.
Select Don't ask me again for this kind of report to remember your choice for all subsequent text
reports (both tab-separated and comma-separated formats). You can change the remembered setting
later in Settings and Preferences.

In single-analyte view, the Analytes tab appears where you can choose to include all or some analytes
in the report:



20400304 Rev. 3.0 51 of 97 Catalog # 40-122

To filter certain analytes from multi-analyte reports, hide columns for those analytes and select the As
Displayed column option (see Show and Hide Table Columns).

Export to Excel

Exporting to a Microsoft® Excel workbook (.xlsx) is supported by the Experiment Results view and the
Raw Data Tab. You can export data in single-analyte format or multi-analyte format (see Single
and Multi-Analyte Views. In single-analyte format, each sheet contains all statistics for an individual
analyte in the file. In multi-analyte format, each sheet contains a particular statistic (i.e. Recovery) for
all analytes.

To export data to Excel, select Export to Excel on the Experiment Toolbar. Depending on your
preferences, the Report Options dialog may appear:
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Use the Columns tab to select what data will be included in the report. Select As Displayed if you want
the arrangement and sorting of the data columns in your report to match the way you have configured
the columns on the screen. Select All Columns to use the application default columns and sorting.
Select Don't ask me again for this kind of report to remember your choice for all subsequent Excel
reports. You can change the remembered setting later in Settings and Preferences.

In single-analyte view, the Analytes tab appears where you can choose to include all or some analytes
in the report:
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To filter certain analytes from multi-analyte reports, hide columns for those analytes and select the As
Displayed column option (see Show and Hide Table Columns).

Export to PDF

The Export to PDF function creates a PDF document version of your Quantitative Experiment

Results. To export your quantitative experiment data to a PDF file, select Export to PDF on the
Experiment Toolbar. The Select Analytes dialog appears where you can choose to include all or some
analytes in the report:
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The PDF report contains sections for header information, experiment results, and excluded wells. The
experiment results section is organized by analyte, and then by the results for each standard curve in the
experiment (if the experiment contains more than one standard curve):
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Interface
The Belysa® immunoassay curve fitting software user interface is primarily divided into several tabs:

l Results Tab
l The Results Tab is where you can view interpolated concentrations, change curve fitting
algorithms, and edit the plate map.

l Raw Data Tab
l The Raw Data Tab is where you can view additional data about each well, as well as auto-
exclude flagged wells.

l Excluded Wells Tab
l The Excluded Wells Tab is where you can view wells that have been excluded from the
results, and re-include them if desired.

l Test Info Tab
l The Test Info Tab contains header information about the file, such as when the test was
conducted. It also is where you can change analyte names if desired.

Additionally, you may wish to modify Settings and Preferences or switch between single-analyte and
multi-analyte views using the Analyte View Toolbar.
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Results Tab

The Results tab is where you can edit plate map information and examine experiment results. The main
parts of the results tab are:

l Plate Tree
l Experiments Tree
l Plate Map Editor
l Experiment Results

Plate Tree

The Plate Tree displays each plate present in your Results file, along with any groups that reside on the
plate.

To rename a plate or group using the plate tree, see Rename Plates and Groups.

Experiments Tree

The Experiments tree displays all Experiments and associated well groups that are contained within
your Results file.

How to create an experiment using the Experiments Tree

To create an experiment using the Experiments Tree, select the Add Experiment button and select the
type of experiment you wish to create (see Create an Experiment). Alternatively, you may right-click
on the tree to activate the shortcut menu and select New Quantitative Experiment (relative potency
experiments can only be created using the Add Experiment button).
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How to remove an experiment or group using the Experiments Tree

To remove an experiment from your Results file, remove a standard curve from an experiment, or
remove a sample group from a standard curve, select the item you wish to remove and then select the

Remove button. You can also select the Remove option from the shortcut menu activated by right-
clicking in the Experiments Tree:
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Plate Map Editor

The Plate Map Editor allows you to create groups and edit well information, such as sample ID, expected
concentration, and dilution factor for a particular plate (see Plates).

The main parts of the Plate Map Editor are:

l Plate Toolbar
l Plate Map
l Well Data Table
l Editor Options Tab
l Plate Details Editor (see Edit Plate Name and Details)

Plate Toolbar

The plate toolbar can be found on the Plate Map Editor and provides access to the following actions:

Icon Title Shortcut Description

Toggle Left Panel Alt+1 Show or hide the left panel

Group As Standard Ctrl+D
Groups the selected wells as standards.
See Create Groups.

Group As Control Ctrl+F
Groups the selected wells as controls.
See Create Groups.

Group As Unknown Ctrl+G
Groups the selected wells as unknowns.
See Create Groups.

Clear Wells
Clears the selected wells. See Clear Well
Information

Cut Wells Ctrl+X
Cuts the selected wells. See Cut, Copy,
& Paste Wells.

Copy Wells Ctrl+C
Copies the selected wells. See Cut,
Copy, & Paste Wells.

Paste Wells Ctrl+V
Pastes the selected wells. See Cut, Copy,
& Paste Wells.



20400304 Rev. 3.0 60 of 97 Catalog # 40-122

Icon Title Shortcut Description

Renumber Replicates
Renumbers replicates on the plate. See
Renumber Replicates.

Show Replicates Show all replicates in the well data table

Hide Replicates Hide all replicates in the well data table

Toggle Right Panel Alt+2 Show or hide the right panel

Plate Map

Group and Well Information

The plate map is found on the Plate Map Editor and displays information about each well on the plate:

Each well is represented as an icon with a particular color, shape, and indicator:
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Element Meaning

Group type icon
A green square represents a standard well. A red circle represents an
unknown well. A blue hexagon represents a control well.

Well status indicator

A green check mark means that the well was included in the source

data and has valid data. A red cross means that the well was included
in the source data, but the result is invalid (for example due to an
instrument error). No indicator means that the well was not included in the
source data.

Well ID
A number representing which replicate group this well is a part of. Wells
with the same Well IDs are replicates of one another.

You can select wells on the plate map by clicking or dragging with the mouse. You may hold down the
Ctrl or Shift keys while selecting wells to make disjoint selections. Once you have selected wells, you
can do things like Create Groups, Clear Well Information, or Cut, Copy, & Paste Wells.

384-Well Plates and Quadrants

When source data is provided in 384-well plate format, Belysa® immunoassay curve fitting software
offers two views of the plate map.

384-Well View

The first view shows all 384 wells in a single table. You can access this view by selecting the plate name
in the Plate Tree:
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Quadrant View

384-well plates are further subdivided into four 96-well quadrants, where each quadrant contains the
following locations:

l Quadrant 1: A1, A3, ..., C1, C3,...
l Quadrant 2: A2, A4, ..., C2, C4,...
l Quadrant 3: B1, B3, ..., D1, D3,...
l Quadrant 4: B2, B4, ..., D2, D4,...

To view the plate map for a particular quadrant, select the quadrant name under the plate in the Plate
Tree

Well Data Table

The well data table can be found on the Plate Map Editor and allows you to view and edit well
information such as sample IDs, expected concentrations, and dilution factors.
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Single-Analyte View

Here is an example of the well data table in single-analyte view:

The table below describes the columns available for display in the table. If the column is marked as
editable, you may edit the value by double-clicking it in the table, or by copying and pasting a new value
over the old one (e.g. from Excel).

Column Name Description Editable?
Row The row for this well No
Column The column for this well No

Well ID
A number representing which replicate group this
well is a part of

No

Sample ID A user-editable identifier for the well Yes
Expected Concentration The expected concentration of this well (if applicable) Yes

Dilution Factor
The dilution factor of this well (unknowns only).
Results for unknown wells are multiplied by this
scaling factor.

Yes

Group The name of the group to which this well belongs No

Multi-Analyte View

Here is an example of a quantitative results table in multi-analyte view:
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In this mode, a single statistic is shown for all analytes. The statistic can be changed by selecting a new
value from the statistic list (see Analyte View Toolbar). The available statistics for the well data table
are (see Single-Analyte section for descriptions):

l Expected Concentration
l Dilution Factor

Editor Options Tab

The editor options tab is located on the Plate Map Editor and gives you more flexibility when laying out
groups.

Control Function
Column Skip Number of columns to skip when selecting wells on the Plate Map
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Row Skip Number of rows to skip when selecting wells on the Plate Map

New Group Behavior

When set to Create a new group, the Create Group Dialog will be
configured to create a new group every time. When set to Append to
last group, the Create Group Dialog will be configured to append wells
to the most recently created group of the same type (if at least one
group of that type has been created in the current session). See Create
Groups.

Experiment Results

The Experiment Results view contains plots and tables showing data about a quantitative or relative
potency experiment (see Experiments). This is also where you can find and exclude outliers from your
data, change the curve fit, and produce reports.

The main parts of the Experiment Results view are:

l Experiment Toolbar
l Standard Curve Plot
l Quantitative Experiment Results or Relative Potency Results tables
l Curve Editor
l Experiment Details tab (see Edit Experiment Name and Details)
l Table Columns tab (see Show and Hide Table Columns)

Experiment Toolbar

The experiment toolbar provides access to the following actions:

Icon Title Shortcut Description

Toggle Left Panel Alt+1 Show or hide the left panel

Zoom In + Zoom in on the standard curve plot

Zoom Out - Zoom out on the standard curve plot

Toggle Exclude O
Exclude or include the selected point on the
standard curve plot
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Icon Title Shortcut Description

Export to TXT
Save a report for this experiment in tab-
separated plain text format (*.txt)

Export to CSV
Save a report for this experiment in comma-
separated variable format (*.csv)

Export to Excel
Save a report for this experiment in Excel
workbook format (*.xlsx)

Export to PDF
Save a report for this experiment in PDF format
(*.pdf). Available for quantitative experiments
only.

Show Curve Alt+3
Hide the results table and show only the standard
curve plot

Show Table Alt+4
Hide the standard curve plot and show only the
results table

Split
Split the view between the standard curve plot
and the results table

Show Replicates Show all replicates in the results table

Hide Replicates Hide all replicates in the results table

Toggle Right Panel Alt+2 Show or hide the right panel

Standard Curve Plot

The standard curve plot displays all standard curves and sample groups contained in the experiment
(see Experiments).

The axes will automatically adjust to best fit the range of your data. Logistic curve fit methods will
automatically use a log scale for the X and Y axis, while the Linear curve fit will use linear scale axes.
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Here are some things you can do with the standard cure plot:

Display Curve and Point Information

Hovering over a curve or sample point with the mouse will display information about the curve or point:

Exclude and Include Wells

To exclude a point from the standard curve plot, select the point by clicking on it. Or, select multiple
points by clicking and dragging a box:
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The selected points are highlighted on the standard curve plot. To exclude selected wells, press the O

key on the keyboard, or select Toggle Exclude from the toolbar (see Experiment Toolbar).

Excluded wells are displayed with a dotted-outline and a faded color:

To re-include the wells, select them and press the O key on the keyboard, or select Toggle Exclude
from the toolbar.

Export as Image File

To export the standard curve plot as an image file, right-click on the standard curve plot to open the
shortcut menu, then select an export option:

l Copy Curve Plot - copies the current plot to your clipboard
l Save Curve Plot as PNG - saves the curve plot as a high-resolution PNG image file
l Save Curve Plot as SVG - saves the curve plot as a scalable vector graphics file, suitable for
printing at any resolution

Note that the saved image will reflect your current zoom and pan settings. Before saving, ensure that the
chart has the desired content visible.

Change Plot Appearance

To toggle the visibility of curves or to change colors, see Change Curve Plot Appearance
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Quantitative Experiment Results

The quantitative results table shows you interpolated concentrations for sample groups in your
experiment. Wells that are part of the same replicate group are rolled-up into single rows in the table,
showing average values where appropriate. To see individual replicate results, expand the row by
selecting the arrow in the Plate column.

Single-Analyte View

Here is an example of a quantitative results table in single-analyte view:

The table below describes the columns available for display in the table. If the column is marked as
editable, you may edit the value by double-clicking it in the table, or by copying and pasting a new value
over the old one (e.g. from Excel).

Column Name Description Editable?
Plate The name of the plate on which this well resides No
Group The name of the group to which this well belongs No
Location The well's row and column location on the plate No
Analyte The name of the analyte whose results are being displayed No

Well ID
A number representing which replicate group this well is a
part of

No

Expected The expected concentration of this well (if applicable) Yes

Unk. Dilution
The dilution factor of this well (unknowns only). Results for
unknown wells are multiplied by this scaling factor.

Yes

Sample ID A user-editable identifier for the well Yes

Standard
The name of the standard group used to obtain results for
this well

No

Fit The curve fit method used to obtain results for this well No

Result
The interpolated concentration for this well as determined
by the standard curve

No

Message
If populated, contains one or more codes containing
feedback from the curve fitting algorithm

No
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Column Name Description Editable?
Result SD Result standard deviation No
Result CV Result coefficient of variation No

MFI or Response
Raw instrument response for this well. Exact definition
varies depending on source of data.

No

MFI or Response CV MFI/Response coefficient of variation No
MFI or Response SD MFI/Response standard deviation No

Recovery
The ratio of interpolated result to expected concentration,
expressed as a percentage

No

n
The number of non-excluded replicates included in this
roll-up

No

Exclude

An indication of whether or not this well (or one replicate of
a duplicate or triplicate) has been excluded. A checked box
means that the well or entire replicate group has been
excluded. A partially filled box means that one or more,
but not all, replicates have been excluded

Yes

Exclude Reason A user-provided reason why the well was excluded Yes

Multi-Analyte View

Here is an example of a quantitative results table in multi-analyte view:

In this mode, a single statistic is shown for all analytes. The statistic can be changed by selecting a new
value from the statistic list (see Analyte View Toolbar). The available statistics for quantitative
experiment results are (see Single-Analyte section for descriptions):

l Expected
l MFI/Response
l MFI/Response CV
l MFI/Response SD
l Result
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l Recovery
l Result CV
l Result SD

Messages

The Message column may display additional information about how a result has been interpreted by the
xPRO software. The possible values for the Message column are:

Icon Name Description

EXT (above curve)

The response
for this well is
near or above
the top of the
standard
curve, and
the
interpolated
concentration
is obtained
via linear
extrapolation

EXT (below curve)

The response
for this well is
below the
standard
curve, and
the
interpolated
concentration
is obtained
via linear
extrapolation

ND

Non-Detect –
the
interpolated
concentration
is below the
LoD

BLOQ, or generic warning

When
accompanied
by the
"BLOQ" label,
this indicator
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Icon Name Description
means that
the
interpolated
concentration
is below the
LLoQ. When
displayed on
a roll-up or
average row,
it means that
one or more
of the
unexcluded
replicates in
this replicate
group have
message
values.

Defects

SMCxPRO®
data files only
- the software
has detected
likely defects
in this well
that may be
affecting
results

Non-Detect Flag

If an individual replicate is flagged as Non-Detect (ND), then by default its interpolated concentration
and recovery are not calculated and are left blank. If a replicate group includes any replicates that are
flagged as Non-Detect, then the mean interpolated concentration, SD, CV, and mean recovery for the
group are not calculated until all Non-Detect replicates are excluded. You can override this behavior in
Analysis.

The ND Flag has no effect on the Standard Curve calculation and all points are used unless marked as
Outlier.

Relative Potency Results

The relative potency results table shows you how one or more curves compares to a designated
reference curve. In a relative potency experiment (see Create an Experiment), the first curve added is
always the reference curve.
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Single-Analyte View

Here is an example of relative potency results in single-analyte view:

The table below describes the columns available for display in the table. More detailed explanations of
each calculation can be found inMathematical Reference.

Column Name Description
Curve The name of the curve being compared to the reference curve
Parallelism A measure of the statistical similarity between the two curves

Relative Potency
A unitless measure obtained from a comparison of the dose-
response relationships of a test curve to a reference curve

CI Low
The lower bound of the 95% confidence interval for the slope
difference between the linear regions of the test and reference
curves

CI High
The upper bound of the 95% confidence interval for the slope
difference between the linear regions of the test and reference
curves

Multi-Analyte View

Here is an example of a relative potency results table in multi-analyte view:

In this mode, a single statistic is shown for all analytes. The statistic can be changed by selecting a new
value from the statistic list (see Analyte View Toolbar). The available statistics for relative potency
experiment results are (see Single-Analyte section for descriptions):

l Parallelism
l Relative Potency
l CI Low
l CI High
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Curve Editor

The Curve Editor tab allows you to alter the appearance and properties of standard curves in your
Experiments, including color, visibility, and curve fit. The Curve Editor displays different information
depending on whether or not you are in single-analyte or multi-analyte view (see Single and Multi-
Analyte Views).

Single-Analyte View

In single-analyte view, the Curve Editor displays information for the currently selected analyte for the
currently selected curve. For explanations of the values presented in this table, see Curve Quality
Statistics. In general, to view information about or edit a curve, follow this procedure:

1. Select the analyte whose curve you wish to view or edit

2. Select the name of the curve

3. The displayed information will reflect the analyte and curve selected in #1 and #2, respectively:
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Multi-Analyte View

In multi-analyte view, select a curve (#1) and the Curve Editor displays the curve fit for all analytes for
that curve (#2). Each analyte's curve fit can be adjusted independently. The statistic filter does not
affect what is shown in the Curve Editor.

Usage

Common tasks performed using the Curve Editor tab include:

l Change Curve Plot Appearance
l Change the Curve Fitting Method
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Raw Data Tab

The Raw Data tab displays information about each well in the data file. In addition to the instrument
response value used for quantitative interpolation, this tab may display other meta-data about each
well, for example defect count or temperature. The exact set of columns available in the raw data table
will vary with the source of the data. The Raw Data table is designed to facilitate identifying and
excluding outliers in your data (see Auto-Flagging).

The main parts of the Raw Data tab are:

l Raw Data Toolbar
l Raw Data Table
l Table Columns tab (see Show and Hide Table Columns)

Raw Data Toolbar

The Raw Data toolbar provides access to the following actions:

Icon Title Shortcut Description

Exclude Flagged

Exclude all currently visible wells that have one or
more flags (see Auto-Flagging). Note: in single-
analyte view, this will only exclude data from the
currently selected analyte. To exclude all wells
with flags for all analytes, select this action while
in multi-analyte view.

Export to TXT
Save a raw data information in tab-separated
plain text format (*.txt)

Export to CSV
Save a raw data information in comma-separated
variable format (*.csv)

Export to Excel
Save a raw data information in Excel workbook
format (*.xlsx)

Toggle Right Panel Alt+2 Show or hide the right panel

Raw Data Table

The raw data table displays detailed information about each well and provides you an easy way to find
and exclude outliers.
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Single-Analyte View

Here is an example of the Raw Data table in single-analyte view:

The columns are described in the table below:

Column Name Description Editable?

Flag

Indicates whether or not this row has any value that has been flagged, and

if so, whether that row has been excluded. The icon indicates that the

row has one or more flagged columns. The icon indicates that the row
has one or more flagged columns, but that the data has been excluded from
results. No icon means that there are no flagged columns in this row. Note:
in single-analyte view, the Flag column only indicates whether or not the
currently visible analyte has flagged data. To see flags for all analytes, use
multi-analyte view (see Single and Multi-Analyte Views).

No

Plate The name of the plate on which this well resides No
Location The well's row and column location on the plate No
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Column Name Description Editable?
Well ID A number representing which replicate group this well is a part of No

Exclude

An indication of whether or not this well (or one replicate of a duplicate or
triplicate) has been excluded. A checked box means that the well or entire
replicate group has been excluded. A partially filled box means that one or
more, but not all, replicates have been excluded

Yes

Exclude Reason A user-provided reason why the well was excluded Yes

Multi-Analyte View

Here is an example of the raw data table in multi-analyte view:

In this mode, a single statistic is shown for all analytes. The statistic can be changed by selecting a new
value from the statistic list (see Analyte View Toolbar). The available statistics for the raw data table
vary depending on the data source.



20400304 Rev. 3.0 79 of 97 Catalog # 40-122

Excluded Wells Tab

The Excluded Wells tab displays all wells and analytes that have been excluded from results calculations
for any reason (see Exclude and Include Wells). It also provides a convenient way to restore all
excluded data.

The main parts of the Excluded Wells Tab are:

l Excluded Wells Toolbar
l Excluded Wells Table

Excluded Wells Toolbar

The Excluded Wells toolbar contains a single action called Restore All . In single-analyte view this
action will restore all excluded wells for the currently selected analyte, or in multi-analyte view this
action will restore all excluded wells for all analytes (see Single and Multi-Analyte Views).

Excluded Wells Table

The Excluded Wells table displays analyte and well data that have been removed from calculations
across all Experiments. You can use this table to re-include data that has been excluded, or see a quick
overview of all your excluded wells and analytes. Note that only excluded wells and analytes are included
in this table. To exclude data for a well or analyte that does not appear in this table, use the Raw Data
Table or the Quantitative Experiment Results.

Single-Analyte View

Here is an example of the Excluded Wells table in single-analyte view:

The table below describes the columns in the table:

Column Name Description Editable?

Plate
The name of the plate on which this well
resides

No

Location The well's row and column location on the plate No

Well ID
A number representing which replicate group
this well is a part of

No

Group
The name of the group to which this well
belongs

No

Sample ID A user-editable identifier for the well No
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Exclude
If checked, this analyte's data for this well has
been excluded from calculations.

Yes

Reason
A user-provided reason why the analyte/well
was excluded

Yes

Multi-Analyte View

Here is an example of a quantitative results table in multi-analyte view:

In multi-analyte view, each row represents a specific well on a plate and the columns are labeled for each
analyte. A well (row) must have at least one excluded analyte to appear in the table. To re-include a
particular analyte, clear the box in the cell at the intersection of the well's row and the analyte's column.
To change the reason for exclusion: double-click in the table cell for the desired well and analyte, enter a
new reason, and press Enter.



20400304 Rev. 3.0 81 of 97 Catalog # 40-122

Test Info Tab

The Test Info tab displays extra information about the data file, such as when the test was run. For some
data formats this information may be referred to as "header data" or "metadata." The Test Info tab also
allows you to view and edit information about the analytes in your file. There are two sections on the Test
Info tab:

Test Info

Select Test Info to view header information about the file. The exact fields will vary based upon the
source of the data.

Analytes

Select Analytes to view information about the analytes in this file:

Column
Name

Description Editable?

Original
Name

The name of the analyte as reported in the original source data No

Current
Name

The name of the analyte as displayed in the software. By default this is the same as
the Original Name, but can be changed to a new name if desired.

Yes

ID
A number uniquely identifying the analyte in addition to its name. For Luminex®
data files this is equivalent to the bead region.

No

Units The units of measure used to express concentration values for this analyte Yes

Precision

The number of decimal places used to express concentration values for this analyte.
Intermediate calculations are carried out using full double precision, and then the
results are rounded to this number of decimal places. To avoid confusion due to
small values appearing as zero, ensure that precision is set to an appropriate
number of decimal places for the quantities and units you are working with.

Yes
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Analyte View Toolbar

The Analyte View toolbar allows you to switch between single and multi-analyte views of your data (see
Single and Multi-Analyte Views). You can switch between analytes (in single-analyte view) or
statistics (in multi-analyte view) by selecting different values in the analyte drop-down box, or typing in
the name of the analyte and pressing Enter.

Here is an example of selecting different analytes in single-analyte view:

And here is an example of selecting different statistics in multi-analyte view:

You can use the keyboard shortcuts Ctrl+E and Ctrl+R to switch between single and multi-analyte
views, respectively. To quickly change between analytes or statistics, press Ctrl+K to move the cursor
to the drop-down box and highlight the current value.
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Settings and Preferences

Belysa® immunoassay curve fitting software provides several configuration options to optimize your
workflow and customize your experience. These options can be accessed by selecting Tools > Settings
from the menu bar.

The User Settings dialog is divided into sections:

Display

Setting Description
Default
Value

Theme
Choose a light or dark appearance. Requires a restart of Belysa® software to take
effect.

Light

Toolbar
When Show Text Under Icon is selected, toolbar icons include a text description of
the action under the icon. When cleared, only the icon is shown. Try clearing this box
to conserve space on smaller screens.

Checked
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Analysis

Setting Description
Default Value
(s)

LLoQ Calculation

Sets the recovery bias and CV% limit values used when
calculating LLoQ. For example, a recovery bias of 20% will
use a recovery range of 80%-120% when calculating LLoQ. A
CV limit of 20% will accept points with CV less than or equal to
20%.

Recovery Bias =
20%

CV Limit = 20%

LoD and MDD Calculation
Sets the coefficients used when calculatingMDD and LoD.
Valid range 1.0-5.0.

LoD Coefficient
= 2.5

MDD Coefficient
= 2.5

Show Results Below LoD
When selected, displays values for results below the LoD.
When cleared, values below the LoD will be reported as "-" in
results tables.

Cleared

Display Units in Results
Table

When selected, units of measure will be included in results
tables.

Cleared



20400304 Rev. 3.0 85 of 97 Catalog # 40-122

Auto-Flag

The Auto-Flagging tab lets you set highlighting rules for different data types. See Auto-Flagging.
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Reports

Excel Reports

Setting Description
Default
Value

Column Options

Controls which columns will appear in the report. When Export
columns as displayed is selected, the report's columns and
sorting will match the way you have configured your experiment
results. When Export all columns is selected, the report will include
all columns with a default sort order. When Ask me every time is
selected, the software will prompt you to choose an option each time
you generate a report.

Ask me
every
time

Analytes
Allows you to select which analytes are included in the report. Select
All Analytes to include every analyte in the file in the report. Select
Let me choose to only include some analytes in the report.

Let me
choose

Text and CSV Reports

Setting Description Default
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Value

Column Options

Controls which columns will appear in the report. When Export
columns as displayed is selected, the report's columns and sorting
will match the way you have configured your experiment results.
When Export all columns is selected, the report will include all
columns with a default sort order. When Ask me every time is
selected, the software will prompt you to choose an option each time
you generate a report.

Ask me
every
time

PDF Reports

Setting Description
Default
Value

Include Warning
Messages

Select this box to include warning messages from the curve fitting
algorithm in the report

Selected

Include Individual
Replicate Data

Select this box to include individual replicate data in the report.
When cleared, only averages for each replicate group will be
reported.

Selected

Analytes
Allows you to select which analytes are included in the report. Select
All Analytes to include every analyte in the file in the report. Select
Let me choose to only include some analytes in the report.

Let me
choose
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Logging

Setting Description
Default
Value

Enable Detailed Logging
Select this box to write log messages to a file, for example to send to
technical support.

Cleared
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Additional Information
This section contains additional useful information about Belysa® immunoassay curve fitting software:

l TheMathematical Reference section contains detailed explanations of the various curve fitting
and statistical methods used in the application

l The Keyboard Shortcuts table provides a quick reference for keyboard shortcuts used in the
application
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Mathematical Reference

See the following sections for detailed information on the mathematical and statistical methods used in
Belysa® immunoassay curve fitting software:

l For information on 4PL and 5PL curve fits, see Logistic Curve Fitting
l For other curve fit options (such as linear and cubic spline), see Other Curve Fitting Methods
l For information on how curve fit statistics such as LoD and LLoQ are calculated, see Curve
Quality Statistics

l For relative potency experiments, see Relative Potency

Logistic Curve Fitting

Belysa® immunoassay curve fitting software provides several logistic curve fitting methods:

Method Description

4PL
The default curve fit selection. Four-parameter logistical interpolation of
the standard curve, of sigmoid shape, to fit the signals of fluorescent
responses with respect to the expected analyte concentration.

5PL
A five-parameter logistical regression of the standard curve, sigmoid
shape. This is essentially a variation of the 4PL, except it may be
asymmetrical about the center of the curve.

Robust 5PL / 4PL
The corresponding curve equation is the same as 4PL/5PL, but the
numerical procedure to fit the 4 or 5 parameters has similar robustness to
potential outliers in the standard data.

The equation for the five-parameter logistic curve (5PL) is given by one of the following formulas:

where y is the response, x is the concentration, and p≡[a, b, c, d, g] is the vector of parameters defined
as:

l a – The bottom or the lower asymptote of the curve
l d – The top or the upper asymptote of the curve
l c – The mid-range concentration or the concentration at the inflection point
l b – The slope of the curve at its midpoint or the rapidity of the curve transition between
asymptotes

l g – The asymmetry factor or the asymmetry around the inflection point

By setting g = 1, the standard curve becomes four-parameter logistic curve (4PL). For 4PL model, c is
also called EC50, the effective concentration corresponding to the middle point response between a and
d.
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Weighted Least Squares Fitting Model

Using the standard curve calibration data, the parameters [a, b, c, d, g] in Equations 1a and 1b are
estimated by the weighted least squares (WLS) fitting model:

where N is the number of standard concentration points, mi is the number of replicates at each
concentration point xi, Yi,j is the measured response for the jth replicate of the ith standard
concentration, f( xi; p) is the regression mean function given by (1), wi is the weight proportional to the
experimental error with the assumption of Var( Yi,j) = σ2 wi-1 with each response, and ϵij is the
independent random errors with a standard normal distribution.

Standard and Robust Variations

The WLS model (2) is generally fitted by minimizing the sum of squares of the errors (SSE) given by:

Belysa® software uses the Nelder-Mead simplex algorithm to search the parameter space of p for the
local minimum solution. Besides standard plate input data, the optimal solution of parameter p for the
fitted logistic curve model also depends on other heuristic factors including the initial values for p, the
weighting method, the iteration stopping criteria, etc.

Belysa® software extracts the response REi,j for each well scan. There are two different choices to
formulate the fitting procedure that depend on fitting logistic functions, different weighting schemes wi,
or using different error functions.

Standard 5PL (4PL) Procedure

5PL (4PL) procedure uses the extracted signals or responses, REi,j, for corresponding concentrations, ci,
as the standard data to fit a 5PL (4PL) logistic formulation as in (1) by an iterative procedure with the
fitting error and weighting functions in (3) defined as follows.

Note: the weighting factor wi is set to be the inverse of the square of the individual response REi,j for well
response above the pre-defined threshold, otherwise it is set to be the inverse of the square of the mean
response of the ith replicate group.

Robust 5PL (Robust 4PL) Procedure

The Robust 5PL (Robust 4PL) procedure is similar to 5PL (4PL) except for using the absolute difference
(L1 distance) between the measured response and the fitted value for the residue error along with the
inverse of the median response in a replicate group as the weight in (3).
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These two different formulation changes are specifically designed to reduce the influence of the outlier
data on the residue error.

Back calculation of the concentration from the response

Equations 6a and 6b above define how concentration [C] can be computed from a given response y or
REi,j. Equations 6a and 6b correspond to the logistic curve fit Equations 1a and 1b, respectively. There
are several special cases where concentration may be obtained via alternate means:

1. When the response y is equal or larger than the upper asymptote, d, the back calculation of
inverse fitted logistic curve by (6) gives positive infinity (+∞). Two nearby standard group points
are used to perform linear extrapolation to compute [C].

2. When the response y is equal or smaller than the lower asymptote, a, the back calculation of
inverse fitted logistic curve by (6) is not well defined. Two nearby standard group points are used
to perform linear extrapolation to compute [C].

3. For the top of curve standard group, or when the response y is very close to the upper asymptote
from below, the back-calculated concentration is the value that results in better recovery between
the equation (6) and the linear extrapolation by the nearby standard group points.

Other Curve Fitting Methods

Linear regression

The simplest model to analyze empirical data is to fit a linear regression line in the form of Y = a + bX,
where X is the explanatory variable (Standards’ expected concentration) and Y is the dependent variable
(Standards’ measured response). The method of weighted least-squares is used to find model
parameters a (line y-intercept) and b (line slope) by minimizing the sum of the weighted squares of the
vertical difference between each data point and the line.

Cubic Spline

A cubic spline curve is a piecewise cubic curve with continuous second derivative. The word “spline”
actually refers to a thin strip of wood or metal that went through the desired data points when curves
were designed for ships and planes at one time. A four knots (3 segments) cubic spline curve with
weighting is implemented based on Netlib library function, dc2fit. Unlike the other curve types, the fitted
cubic spline is represented by three cubic curves formulated by three 4-elements vectors: X knots
(concentrations), Y knots (responses), and YP knots (first derivative of responses). For most assay data,
cubic spline curve is usually not the model that produces the best recovery and C.V., instead it can be
used to check against complicated (e.g. multiphase) or abnormal (wavy) relationship between the
response and the concentration in the data.

In Belysa® software, the equation for a cubic spline curve is displayed as follows:
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where kx is the the X (concentration) knot vector, ky is the Y (response) knot vector, and kyp is the Y's
first derivative knot vector.

Curve Quality Statistics

Belysa® immunoassay curve fitting software provides several statistics that can be useful to evaluate
your standard curve and assay performance. These can be found on the user interface in the Curve
Editor.

Equation

Each standard curve is defined by its equation. Belysa® software displays the equation for each curve in
plain-text format. The equations for logistic curve fits are described in the Logistic Curve Fitting
section, and equations for other curve fits are described in the Other Curve Fitting Methods section.

Weighting

The weighting function affects how the curve fit parameters are calculated and describes how the
variance changes in relation to the concentration. For most curve fit options, the weighting function used
is 1/y2. For Robust curve fit options, the weighting function used is 1 divided by the median value of the
replicate group (or the average if 2 or fewer replicates).

LLoQ

The LLoQ, Lower Limit of Quantification (Quantitation), is defined as the standard with the lowest
concentration satisfying three conditions:

a. The back-calculated analyte concentration CV is less than or equal to 20% (or custom value
specified in Analysis)

b. The recovery rate of back-calculated analyte concentration is in [80,120]% (or custom value
specified in Analysis)

c. All the standards above the LLoQ that also satisfy conditions a and b.

MDD

The MDD (Minimum Detectable Dose) concentration is defined as follows:

where S is the inverse of the standard curve function and C is a user-configurable coefficient (see
Settings and Preferences). The standard deviation of the blank response is subtracted from the mean
in the case of competitive assays, otherwise it is added. If no blank wells are present in the standard
curve or interpolation fails, a value of "N/A" is reported.
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LoD

The LoD (Limit of Detection) is the lowest concentration of an analyte that can be reliably detected from
background noise. LoD is defined as:

where L is the inverse of the function defined by the least squares regression line that best fits the first
three standard groups (starting from the blank) and C is a user-configurable coefficient (see Settings
and Preferences). The term containing the standard deviation of the blank response is subtracted from
the mean in the case of competitive assays, otherwise it is added. If no blank wells are present in the
standard curve or interpolation fails, a value of "N/A" is reported.

R-squared

R-squared, also called the coefficient of determination, is a value to measure how much variation of
response variable is explained by the fitted model, defined as:

Usually the closer R-squared value to 1, the better fit the model is to the data, but one needs to combine
R-squared value with the residual variance to guard against any bias in the fitting.

Slope

Slope is defined as the slope of the least square regression line using all replicates of non-blank
standards except the highest concentration standard. Slope provides a measure of how steeply the
response increases with respect to concentration for standards in the low-to-high concentration
segment.

Curve Optimization

Automatic best curve fitting and outlier removal (optimization) is a procedure to decide the best curve
that fits the standard data with the identified outliers being removed. The following criteria in descending
importance order are followed to determine the best curve (see Curve Quality Statistics for
definitions):

1. Lowest LLoQ point with the smallest concentration

2. Lowest LLoQ total error as the sum of CV and Recovery

3. Highest R-Squared

4. Model with fewest number of parameters

The optimization procedure is a multipass iterative process to find the best fit that meets the above
criteria. These following rules are used to end the searching process:

1. Current LLoQ point is already the point before the blank point

2. Number of removed outliers reaches the pre-defined limit



20400304 Rev. 3.0 95 of 97 Catalog # 40-122

3. No more replicates are eligible to be removed because:

a. Each replicate group must have at least two replicates

b. It is not allowed to remove the whole replicate group

c. At current LLoQ point, it only searches its immediate neighbors which does not give a
better outcome

The detection of outliers is based on the assumption that the curve fit residuals are normally distributed,
therefore, any replicates with outlying residual errors are potential outliers to be considered for removal.
More specifically, the algorithm is as follows:

1. Global outliers are first identified as those replicates that have curve fit residual outlying beyond
the Tukey’s outlier test, and then removed from the standard data.

2. Potential local outliers are then iteratively inspected point by point starting from current LLoQ
point. The decision to remove the identified local outlier is based on if it improves the LLoQ with
the local outlying criteria as:

a. The local outliers value has the largest deviation from the mean that is beyond at least one
standard deviation, or

b. The local outlier is the replicate which produces the largest residual from the least squares
linear regression fitting with local groups

Relative Potency

Relative potency assays help provide assurance of the quality and consistency of biopharmaceutical
products. Assuming that the Standard and Test materials contain samples with biologically similar
activity, the Test sample can be expected to behave like a concentration or dilution of the Standard and
parallelism between the Test and Standard concentration-response segments should be present. Log
relative potency is determined to be the horizontal displacement between the curves at the same Test
and Standard assay response. The key assumption about the Test and Standard curves is also termed as
statistical similarity, which assesses the parallelism of standard and test samples in parallel-line or
parallel-curve models. Our implementation adopts the parallel-line model for relative potency
determination1.

Given two curves corresponding to two samples, one Standard sample and the other Test sample, here
are the steps to calculate the relative potency and its confidence interval.

1. Select the linear range (LR) of dose-response curves as the concentration points that fall between
pre-specified START and END groups.

2. Calculate the 95% confidence interval (CI) for the slope difference between the two least squares
fitted lines. To measure the statistical similarity between the two curves, use equivalent test
procedure to compare the CI against the pre-determined equivalent interval (EI).

1Bortolotto, E & Rousseau, R & Teodorescu, B & Wielant, A & Debauve, G. (2015). Assessing similarity
with parallel-line and parallel-curve models: Implementing the USP development/validation approach to
a relative potency assay. BioProcess International. 13.
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3. Establish statistical similarity by computing the slope ratio between the Standard and the Test
sample as the parallelism.

4. Finally, the relative potency is calculated using the Standard slope as the common slope for both
least squares fitted lines:

RP = exp(Test_intercept – Standard_intercept)/Standard_slope)

5. The 95% confidence interval (CI) of RP is estimated by using Fieller’s Theorem1

6. RP value of 1 is regarded as the completely equivalency between the Standard and the Test
samples; RP value of less than one indicates the Standard sample is more potent than the Test
sample, or vice versa.

1Buonaccorsi, J. P. (2014). Fieller's Theorem. In Wiley StatsRef: Statistics Reference Online (eds N.
Balakrishnan, T. Colton, B. Everitt, W. Piegorsch, F. Ruggeri and J. L. Teugels).
doi:10.1002/9781118445112.stat05858
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Keyboard Shortcuts

General

Shortcut Description
Ctrl+O Open a file
Ctrl+S Save current file
Ctrl+W Close current file
Ctrl+Q Quit application
Ctrl+1 Switch to Results Tab
Ctrl+2 Switch to Raw Data Tab
Ctrl+3 Switch to Excluded Wells Tab
Ctrl+4 Switch to Test Info Tab
F1 Show help
Alt+1 Toggle left panel
Alt+2 Toggle right panel
Ctrl+E Switch to single-analyte view
Ctrl+R Switch to multi-analyte view
Ctrl+K Change filter value
Ctrl+Shift+P Jump to first plate
Ctrl+Shift+E Jump to first experiment
Ctrl+Z Undo
Ctrl+Y Redo

Plate Map

Shortcut Description
Ctrl+D Create standard group from selected wells
Ctrl+F Create control group from selected wells
Ctrl+G Create unknown group from selected wells
Ctrl+X Cut selected wells
Ctrl+C Copy selected wells
Ctrl+V Paste selected wells

Experiment Results

Shortcut Description
Alt+3 Show curve full screen
Alt+4 Split view between curve and table
Alt+5 Show table full screen
+ Zoom in on chart
- Reset chart zoom
O Exclude/include selected point on chart
Alt+[Drag] Zoom in on box in chart
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